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How to Access the BioNet Web Service
using Power Query

This document provides a quick guide on how to extract data from the BioNet Web
Service using Excel with Power Query. It is intended to get you started and does not
provide exhaustive guidance on using Power Query. Additional Information on using
Power Query is available at: Microsoft Power Query resources.

Who is this guide for?

This guide is intended for users who need to construct customised queries of data held
in BioNet Atlas and BioNet Vegetation Classification.
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1. Before you begin

The Power Query experience is available in all Excel 2016 or later Windows stand-alone
versions and Microsoft 365 subscription plans on the Data tab in the Get & Transform

group.

Before you start, ensure that you are using one of the supported versions of Excel.

Data from BioNet Atlas and BioNet Vegetation Classification have been compiled into
entity sets which are defined by the following data standards:

e Species Sighting Data Standard

e Flora Survey Data Standard

e Vegetation Classification Data Standard

¢ NSW Landscapes Data Standard

e Threatened Biodiversity Data Standard

e Species Names Data Standard

e Thesaurus Data Standard

Access the data standards on the BioNet web services page.

You accept the Terms and conditions of use when extracting data via the BioNet Web
Service.

If you see a box like this, it contains important information to stop
problems or errors occurring. Make sure you read box information and
read the whole document before you start.
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https://www2.environment.nsw.gov.au/topics/animals-and-plants/biodiversity/nsw-bionet/web-services

2. Connect to the BioNet Web Service
using basic authentication

Step 1: Open the Data tab in Excel.

File  Home Insert  Page Layout Furmulaswiew View  Automate  Developer Help  Content Manager © Comments | |¢3 Share ~
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Data » EH From Table/Range [[5 Existing Connections |y« al T T g—w 4 K FamEl B
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Step 2: In the ‘Get Data’ section of the Data ribbon, select ‘From Other Sources’ and
click on ‘From OData Feed'.

File Home Insert Page Layout Formulas Data Review View Automate Developer Help Content Manager 1 Comments | |22 Share
[BiFrom Text/csv  E& From Picture ¥ |— [T Queries & Connections @ l . ? S% = E M 8=
E z
= [® From Web [® Recent Sources ~ S B =2
Get . . Refresh Organization  Stocks 2| Sort  Filter Textto _, What If Forecast | Outline
Data v |EE} From Table/Range [P Existing Connections |~ + B A \_’Advanced Columns 58 ¥ B | Analysis~  Sheet .
. N Queries & Connections Data Types Sort & Filter Data Tools Forecast
From File
e
[% From Database 4
D E F G H | J K L M N o P Q R 5

& From Azure 4
? From Power Platform  *
[E) From Online Services » @ From Table/Range
[‘gq From Other Sources b [‘?@ From Web

% Combine Queries , [E From SharePoint List

BZ Launch Power Query Editor... E—'?E From OData Feed

Step 3: In the OData Feed URL dialogue box enter
https://data.bionet.nsw.gov.au/biosvcapp/odata and click ‘OK’.

OData feed

@® Basic O Advanced

URL
https://data.bionet.nsw.gov.au/biosvcapp/odata

Step 4: The first time you connect to the service a window will appear asking how you
would like to access the data.

For registered users of BioNet Atlas, select the Basic option, enter the User name and
Password associated with your account, and click ‘Connect’.

Your subsequent queries will return data at the level determined by your BioNet Atlas
account credentials.
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https://data.bionet.nsw.gov.au/biosvcapp/odata

Anonymous

Windows

Web API

Organizational account

OData feed X

EE https://data.bionet.nsw.gov.au/biosvcapp/odata

User name
Password

Select which level to apply these settings to

https://data.bionet.nsw.gov.au/ -

Back Cancel

If you are not a registered user of BioNet Atlas, you can access the public level data by
selecting Anonymous and clicking ‘Connect’.

Anonymous

Windows

Basic

Web API

Organizational account

QOData feed X

EE https://data bionet.nsw.gov.au/biosvcapp/odata
Use anonymous access for this OData feed.

Select which level to apply these settings to

https://data.bionet.nsw.gov.au/ -

Back Cancel

All subsequent queries will be configured against these credential settings. If at any
stage you wish to change which credentials you have provided to access the BioNet

Web Service, you can do so from the Query Builder Editor (Step 6) by selecting Data

Source Settings > Edit Permissions > Edit and updating your credentials.
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f'-)"j [‘\ [ Properties ] L Wy EmR 4] Y % Data Type: Text = [ Merge Queries - g I—-‘w New Source ~
~ : ! 1 F 1 =1
H %7 [ advanced Editor X HH HEH Zl [ = Use First Row as Headers ~  °F Append Queries | L4 [k Recent sources =
Close & Refresh — Choose Remove  Keep Remove split Group ;. : ; g manage | Data source
Load 5 pmeters settings
Close| . Bmeters Data Sources New Query
Data source settings ;
> dcterms_bibliographicCitation " Que
Manage settings fer the data sources used in queries. 3 y
Net Atlas of NSW Wildlife 5/01/2025 1:00 AM +11:01
E Net Atlas of NSW wildlife 5/01/2025 1:00 AM +11:01 4 PROPER!
@ ® Data sources in current workbook Global permissions
& Net Atlas of NSW Wildlife 5/01/2025 1:00 AM +11:01 Name
4] Net Atlas of NSW Wildlife 5/01/2025 1:00 AM +11:01 Speciess
= : ) % Net Atlas of Nsw wildlife 5/01/2025 1:00 AM +11:01 All Prope
£ httpsy//data bionetnsw.gov.au/biosvcapp/odata 0 ) Net Atlas of Nsw wildiife 5/01/2025 1:00 AM +11:01
Edit Permissions let Atlas of NSW Wildlife 5/01/2025 1:00 AM +11:01 4 APPLIED
[ﬂ https://data.bionet.nsw.gov.au/biosvcapp/odata Net Atlas of NSW wildlife 5/01/2025 1:00 AM +11:01 Sourt
Net Atlas of NSW Wildiife 5/01/2025 1:00 AM +11:01 X Navig
Credentials Net Atlas of NSW Wildlife 5/01/2025 1:00 AM +11:01
Type: Basic Net Atlas of NSW Wildlife 5/01/2025 1:00 AM +11:01
Net Atlas of NSW Wildiife 5/01/2025 1:00 AM +11:04
Edit... Delete
Net Atlas of NSW Wildlife 5/01/2025 1:00 AM +11:01
OData feed X
Anonymous £ https://data.bionet.nsw.gov.au/biosvcapp/odata
Use anonymous access for this OData feed.
Change Source. Edit Permissions... fiear Permissions | =
Web API
Organizational ac
25 [Hi ation BIoNET Atlas of NSW WiTdIite
26 | HumanObservation BioNet Atlas of NSW Wildlife Cancel

27| ¢

QT FATTIRANG GO0 DAAC

Step 5: Select the entity set (data table) that you want to access and click "Transform

Data’.

Navigator

SpeciesSightings_CoreData

[ Select multiple items

Preview downloaded on Wednesday

Display Options ~

4 FB htipsy//data.bionet.nsw.gov.au/biosvcapp/odata [18]
NSWLandscapes_MitchellLandscapes
SpeciesNames

SpeciesSightings_AdditionalMeasurementsOrFacts

basisOfRecord

HumanObservation
HumanObservation
HumanObservation
HumanObservation

HumanObservation

collectionCode

BioNet Atlas of NSW Wildlife
BioNet Atlas of NSW Wildlife
BioNet Atlas of NSW Wildlife
BioNet Atlas of NSW Wildlife
BioNet Atlas of NSW Wildlife

SpeciesSightings_CoreData
SpeciesSightings_DeletedRecords
SystematicFloraSurvey_SiteData

Thesaurus
ThreatenedBiodiversity_EcologicalCommunities
ThreatenedBiodiversity_KeyThreateningProcesses
ThreatenedBiodiversity_Populations
ThreatenedBiodiversity_Species
ThreatenedBiodiversity_TECGeographicData
ThreatenedBiodiversity_TPGeographicData
ThreatenedBiodiversity TSGeographicData
VegetationClassification_PCTBenchmarks
VegetationClassification_PCTDefinition

VegetationClassification_PCTGrowthForm

HHAHEBEEABEHEAEHASHEABABA

VegetationClassification_PCTStratumData

Select Related Tables

© The datain the preview has been truncated due
to size limits.

Load |~ Transform Data Cancel
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If you click ‘Load’ at this stage, Power Query will try to extract all
records to Excel and if the record count in the selected entity set
exceeds the Excel row limit the query will fail.

Step 6: You will now see the Power Query Editor window and be able to create your
query. See Section 3 of this guide for help on creating a simple query.

Bl vome  ensorm  AddCoumn  view (7]
P [> [ Properties D L 8l 1 =, Data Type: Text © [ Merge Queries ~ D [ New Source ~

A

s x rin BE [ recemt sourcs

[ ¢ Advanced Editor il

[ Use First Row as Headers ~ "% Append Queries ~

Closes. Refiesn Choose Remove  Keep Remove split  Group ) Manage  Datasource
Load~  Preview~ - Manage Columns ~ Columns*  Rows~ Rows ™ Column~ By 2 Replace Values @iz s Parameters™  settings E=reEn
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
S < | @ This preview may be up to 2 days old. | Refresh
Queries [1] -
S Query Settings X
[ SpeciesSighting... T . .
fx || = source{[Name="speciesSightings_CoreData",Signature="table"]}[Data] v
4 PROPERTIES
3. | M basisofRecord ~ | % collectionCode - | Mc dataGeneralizations | - [ 12 datasetiD ~|[ 8 datasetName R
1 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 DPIE Data from Scientific Lice ‘ SpeciesSightings_CoreData
2 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice, )
= Al Properties
3 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 DPIE Data from Scientific Lice,
4 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice: 4 APPLIED STEPS
5 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice, Source
6 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 DPIE Data from Scientific Lice: X Navigation
7 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 DPIE Data from Scientific Lice,
8 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 | DPIE Data from Scientific Lice
9 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice:
10 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice,
11 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 DPIE Data from Scientific Lice:
12 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
13 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 | DPIE Data from Scientific Lice
14 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
15 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
16 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
17 |HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
18 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 DPIE Data from Scientific Lice
19 |HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
20 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 DPIE Data from Scientific Lice
21 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
22 | HumanObservation BioNet Atlas of NSW Wildlife null 1155  DPIE Data from Scientific Lice
23 | HumanObservation BioNet Atlas of NSW Wildlife null 1155 | DPIE Data from Scientific Lice ¥’
24| ¢ >
)5 COLUMNS, 999+ ROWS  Column profiling based on top 1000 rows PREVIEW DOWNLOADED ON WEDNESDAY
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3. Connect to the BioNet Web Service
using API token authentication

Users who have a BioNet Atlas account can alternatively choose to pass an API token
for authentication. APl tokens provide additional security for users and business
systems.

Step 1: Open the Data tab in Excel.

File  Home  Insert  Pagelayout  Formulas| Data Review View  Automate  Developer  Help  Content Manager 2 Comments | |3 Share
: : — " 5
[ByFrom Text/Csv G From Picture ~ [ Queries & Connections - A . ? = E & 8 1 B2 iz}
& = L &8 5 E3
Get b

[ From Web [ Recent Sources - -
Rofresh Orgenizaticn: & - Sort  Filter to What-Hf Forecast | Qutline
e Organization  Stacks [ | Z o
Data v EH From Table/Range [P Existing Connections All v il Y& Advanced | Columns =l i Analysis ¥ Sheet

Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools Forecast ~

Step 2: In the ‘Get Data’ section of the Data ribbon, select ‘From Other Sources’ and
click on ‘From OData Feed'.

File Home Insert Page Layout Formulas Data Review View Automate Developer Hel, Content Manager 1 Comments | |12 Share
leJ5 = E P g
[BFrom Text/csv  E&From Picture v |— [F Queries & Connections A [Z]A] S% =g 4 8= @: @ 58
e & B m 3L [ S ? :
[ From Web [® Recent Sources ~E - 2B B =2 ! -
Get . . Refresh Organization  Stocks 2| Sort  Filter Textto _, What-If Forecast | Outline
Data v |EE} From Table/Range [P Existing Connections |~ + B A Wacmed | @limms =5 © BB | Analysis~  Sheet .
. N Queries & Connections Data Types Sort & Filter Data Tools Forecast
From File
e
[% From Database 4
D E F G H I J K L M N o P Q R S

A\ feom e .
? From Power Platform »
[E) From Online Services » @ From Table/Range

[‘gq From Other Sources b [‘?@ From Web
i i » D From SharePoint List
25 i e S

BZ Launch Power Query Editor... E—'?E From OData Feed

Step 3: In the OData Feed URL dialogue box enter
https://data.bionet.nsw.gov.au/biosvcapp/odata and click ‘OK’.

OData feed

® Basic O Advanced

URL
https://data.bionet.nsw.gov.au/biosvcapp/odata
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Step 4 The first time you connect to the service a window will appear asking how you
would like to access the data. Select ‘Anonymous’ and click ‘Connect’.

OData feed X

Anonymous EE https://data.bionet.nsw.gov.au/biosvcapp/odata

Use anonymous access for this OData feed.
Windows v

Select which level to apply these settings to

Basic https://data.bionet.nsw.gov.au/ -

Web API

Organizational account

Back Cancel

Step 5 Select the entity set (data table) that you want to access and click "Transform
Data’.

Navigator

P SpeciesSightings_Core... &
Select multiple items Preview downloaded on Tuesday, 18...

Display Options ~ D} basisOfRecord collectionCode

i . HumanObservation BioNet Atlas of NSW W
4 E https://data.bionet.nsw.gov.au/biosvcapp/odata [18] A ; ob " Biotet Atlos of NSU W
uman servation 10NE’ as o

NSWlandscapes Mitchelllandscapes HumanObservation BioNet Atlas of NSW W
SpeciesNames HumanObservation BioNet Atlas of NSW W
SpeciesSightings_AdditionalMeasurementsOrFacts HumanObservation BioNet Atlas of NSW W
Spedleiy iz Lansbein 0 The data in the preview has been
SpeciesSightings_DeletedRecords truncated due to size limits.
SystematicFloraSurvey_SiteData

Thesaurus

ThreatenedBiodiversity_EcologicalCommunities

ThreatenedBiodiversity KeyThreateningProcesses

ThreatenedBiodiversity_Populations

ThreatenedBiodiversity_Species

ThreatenedBiodiversity_TECGeographicData

ThreatenedBiodiversity_TPGeographicData

ThreatenedBiodiversity_TSGeographicData

VegetationClassification_PCTBenchmarks

VegetationClassification_PCTDefinition

VegetationClassification_PCTGrowthForm

HHHAEEAAEEHEEEAAE@ABAAA

VegetationClassification_PCTStratumData L 4 >

©v
™

elect Related Tables Load |~ Transform Data Cancel
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Step 6 Prepare your code to integrate your APl token into the Power Query Editor. The
API token is passed directly in the code line. To access the code screen, select
View>Advanced Editor.

m =  SpeciesSightings_CoreData - Power Query Editor

“ Hame Transform Add Colum View

| Ijﬂ Formula Bar  [] Monospaced  [J Column distribution | *[J Always allow [H

[ (1

[V show whitespace [] Column profile

Query ) Go to Advanced Query
Settings L} Column quality Column Editor ependencies
Layout Cata Preview Columns Parameters Advanced ependencies

The Advanced Editor screen will display.

SpeciesSightings_CoreData

let
Source = OData.Feed("https://data.bionet.nsw.gov.au/biosvcapp/odata™, null, [Implementation="2.8"]),
SpeciesSightings_CoreData_table = Source{[Name="SpeciesSightings CoreData",Signature="table"]}[Datal
in
SpeciesSightings_CoreData_table

Replace the line of code

Source = OData.Feed("https://data.bionet.nsw.gov.au/biosvcapp/odata”, null,
[Implementation="2.0"]),

with

accessToken = "Paste your API token here",

Source = OData.Feed("https://data.bionet.nsw.gov.au/biosvcapp/odata/", null,
[Headers = [#"access_token" = accessToken], Implementation="2.0"]),

Step 7 Generate and retrieve your APl token

Navigate to the BioNet Atlas API token module and log in by passing your BioNet Atlas
credentials. Click ‘Generate’ APl Token’, then ‘Copy API Token’. You will paste this
token when instructed in Step 8.

Note: This module can also be accessed from the User Profile pop-up within BioNet
Atlas.

How to access the BioNet Web Service using Excel Power Query


https://data.bionet.nsw.gov.au/SelfServeUser

s
"_‘_\‘L’)’ BioNet Data Warehouse : User settings
N

NSW Department of Climate Change, Energy, Environment and Water
GOVERNMENT

Welcome, JOHN

Please log out of this module when you have completed your task

Log out

Username

bionetatlas_user@yopmail.com

Firstname

John

Surname

Smith

APl Token

INQIpwZIh0G5wNw5DbOHItLRSP1kiaqfZfUfRKHSQDY =:T+10UWgqJQ10bWMxTfym16V2fWfaEUmu91I5P/
OHOEAONAXAsZPtxJfH+gj4zOVwDiOwVvHgvukCqXiNtO7jkfQUAY7 Se7xri

Generate API Token Copy API Token

Token issued
17/04/2025

Note: The API token is unique to your user account. Do not share this token. If you
generate a new token your old token will be automatically expired.

How to access the BioNet Web Service using Excel Power Query
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Step 8

Return to the Power Query Advanced Editor screen. Paste your API token between
“Paste your API token here” being careful to not paste over the quotation marks.

accessToken = "Paste your API token here",
becomes

accessToken =
"InQlpwZlhOG5wWwNw5DbOHItLRSP1kiaqfZfUFRKHSQDY=T+IOUWqJQ10bWMxTfym16V?2
fWfaEUmu91l15P/OHOEAONAXxAsZPtxJfH+gj4zOVwDiOwVvHgvukCgXiNtO7jkfQU4Y7Se
7xri",

Your code should now resemble the below, but with your unique API token.

SpeciesSightings_CoreData

let
accessToken = "InQIpwZlh@GSwNwSDbOHItLRSP1kiagfZ FUFRKHSQDY=: T+I0UNqIQ1ObWMxTfym16V2fWfaEUmu9115P/OHOEAONAXASZPEx1fH+g]4z0VwDiBwVvHgvukCaXiNt07 jkfQUAY7Se7xri”,
Source = OData.Feed("https://data.bionet.nsw.gov.au/biosvcapp/odata/”, null, [Headers = [#"access_token" = accessToken], Implementation="2.8"1),
SpeciesSightings_CoreData_table = Source{[Name="SpeciesSightings_CoreData”,Signature="table"]}[Data]

SpeciesSightings_CoreData_table

Select Done and you will be returned to the Query Builder screen. You can then begin to
construct your query.
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4. Building queries and extracting data

This guidance is intended to help get you started with a simple query. It is not
exhaustive and serves to illustrate some important limitations and considerations in
creating a query.

Keep your queries as simple as possible. Power Query allows very
complex queries to be constructed, but when applied to large datasets
performance can be an issue. The best approach is to apply one or 2
filters, select only the columns you want to retain, and download the
data. Complete further data processing on your own machine.

4.1 Apply afilter

You must apply a filter to the columns to reduce the data you extract
for some entity sets. If you do not apply a filter, Power Query will try to
extract all records and may exceed the row limit in Excel.

Step 1: Click on the header of the column you would like to apply your filter to. In many
cases the filter item you are looking for will appear in the drop-down list. Select the
item(s) you will filter on and click ‘OK’.

iclaturalCode | ~ ||A% order ~ | AB- scientificName ~ | |AB

4| Sort Ascending (Le
(@
&

%| Sort Descending

(Le
(€l
Remove Empty Vig
Text Filters |16
(v
(st
1) (Select All) (s
Acanthiza chrysorrhoa (Le
Acanthiza pusilla Vi
Acanthophis antarcticus (Ci
Acanthorhynchus tenuirostris (P
Accipiter cirrocephalus s
Accipiter fasciatus (Lt
Accipiter novaehollandiae (©
Aegotheles cristatus (st
Aepyprymnus rufescens Bo
Ailuroedus crassirostris
[ecturs lathami]

<

Alisterus scapularis
Amaurornis moluccana
Anas superciliosa V]

Anhinga novaehollandiae

I, List may be incomplete. Load more

How to access the BioNet Web Service using Excel Power Query

12



If what you are searching for does not appear in the filter list, do not
click on Load more. This will try to download all records from BioNet to
complete the list. Use the text filter (see screen shots below).

Step 2: If the item is not displayed in the drop-down menu by default, click on ‘Text
Filters’ and use the ‘Equals’ option.

- - -
R e O

2| Sort Ascending Gould, 1840
Z| Sart Descending {Latham, 1801}
(EMis, 1782)
vigors & Horsfield, 1827
Remove E'-‘-El'.\.f e s
AT RSl A T E—
Text Filters ¥ Equals..
BT P AT

7 (Sebect All Begins With...
| Acanthiza chrysorrhoa b Does Mot Begin With.,
| Acanthiza pusilla Ends With...
S Aeanithophes setancin Does Not End With
~| Acanthorhynchus tenuirostris
¥| Accipiter cimocephalus Contains.
~| Accipiter fasciatus Does Mot Contain...
+| Accipiter novaehollandiae
+| Aegotheles cristatus i i s
¥| Aepyprymnus rufescens i
¥ Ailuroedus crassirostris TEmmingk, 121
| Alectura lathami St
+| Alisterus scapulans
» Amaunormis moluccana
| Anas superciliosa g
+| Anhinga novaehollandiae
1. List may be incomplete. sad more

O Cancel

Using options other than ‘Equals’ may cause very long running queries
and time-outs. Do not use the ‘Contains’ option as this type of search is
not supported by the BioNet Web Service and the query may time out.
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Step 3: In the dialogue box that appears, enter what you are searching for. You can
include more than one item. Then click "OK’.

Filter Rows

Apply one or more filter conditions to the rows in this table.

Basic O Advanced
Keep rows where 'scientificName’

equals - Eulamprus leuraensis -
®And OoOr

h Enter or select a value h

Cancel

Step 4: The preview will then display up to the first 1,000 records matching your query.
Note that in the Query Editor you may not see all records if they exceed 1,000.

Bl | < | SpeciesSightings_CoreData - Power Query Editor X
Home  Transform  AddColumn  View 2]
,,)’_j [ Properties L Y, EPX 4| 1 % Data Type: Text ~ {55 Merge Queries ~ D New Source ¥
~ - )
H = [ Advanced Editor X HH B il it [T Use First Row as Headers ~ & Append Queries ~ e [ Recent Sources ~
Close &  Refresh = Choose  Remove Keep Remove Split  Group | o Manage Data source =
Load™  Preview » L Manage Columns ¥ Columns™  Rows™ Rows” Columnv By  w2Replace Values Conbinclics Parameters  settings Eoteg=t
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
Queries [1] < fx = Table.SelectRows(SpeciesSightings_CoreData_table, each [scientificMame] = "Eulamprus leuraensis” v 3
- £ S gneings | = t ! a ) Query Settings X
[ speciesSighting...
. ~ || A% nomenclaturalCode |~ || A% order ~ || 4 scientificName -7 | A8 scientificNameAuthorship ~ || Afc scient
- - 4 PROPERTIES
1 ICZN Squamata Eul ells & Wellington, 1084 215
A Name
2 IcZn Squamata Eulamprus leuraensis ells & Wellington, 1084 215
SpeciesSightings_CoreData
3 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
4 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 215 All Properties
5 ICZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215 e
6 ICZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215 .
ource
7 ICZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215 X
Navigation
8 ICZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215 y
X Filtered Rows
9 ICZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
10 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
11 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
12 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
13 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
14 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
15 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
16 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
17 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
18 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
19 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
20 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
21 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
22 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
23 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215
24 IcZN Squamata Eulamprus leuraensis ells & Wellington, 1984 2215 W
25 17 P - o —— — Lollc 2 Wrallinton 1024 2718
— <
95 COLUMNS, 199+ ROWS  Column profiling based on top 1000 rows PREVIEW DOWNLOADED ON WEDNESDAY
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4.2 Reduce the number of columns returned

Selecting only the columns of data you are interested in makes the download quicker
and more efficient. This is not a mandatory step.

Step 1: Click on the ‘Choose Columns’ button.

Home | Tansorn  Adicduze Ve
Ab [ [ Properties Y, WX 4| o DataType:Text~ [ Merge Queries ~ j [E‘ [ New Source ~
EJ L& [ Advanced Editor SEEE=E l | == 0 Use First Row as Headers ~ | . Append Queries - S I [B Recent Sources =
Close &  Refresh Choose  Remove Keep Remove Split  Group Manage Data source =
Load~  Preview~ [ Manage ™ olumns  Columns ~ ll Rows ~ Rows ~ Column~ By 2 Replace Values Eofals Parameters~  settings [ enter Data
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources. New Query
. . ‘ ’
Step 2: Choose your columns from the Choose columns window and click ‘OK’.
4.3 Extract the data to the Excel spreadsheet
H ] 1
Step 1: Click on the ‘Close & Load’ button to load your data to your spreadsheet.
| I e s A
L [y Properties L Y, EBX 4| 1 Data Type: Text ~ [F5 Merge Queries ~ [ New source ~
& B Y BE L= E A= I
& [ Advanced Editor il [ Use First Row as Headers * "% Append Queries ~ [[% Recent Sources ~
Close&  Rilifresh Choose  Remove Keep Remove Split  Group | - Manage  Data source
Load~  pofview~ ) Manage Columns ~ Columns~  Rows~ Rows~ Column~ By *2 Replace Values Combine Files Parameters~  settings 7 Enter Data
Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query

-

Step 2: You will be returned to the spreadsheet table. Your data will now commence
loading. Note, in the Workbook Queries side bar you will see the query executing and
should see the number of rows increasing until it is finished. If you would like to stop it,
right click on the query and select ‘Cancel’.

Queries & Connections vooX

Queries | Connections

1 query

" SpeciesSightings_CoreData
58 KB from data.bione 5z Copy

EZ Edit
Cancel
By Duplicate
@ Reference
.’_’,_'j Merge
: Append
Move To Group 4

Show the peek

2y Properties..
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4.4 How to refresh your extracted data

When you save your workbook, the queries that you have created will be saved with it.
The next time you open the workbook you can refresh your queries to extract the most
up to date data from the Data ribbon by clicking ‘Refresh All'.

File Home Insert Fage Layout Formulas FEview View

ﬁ [h From Text/CSY ['-%\_1 From Picture ~ I:'h [T bueries & Connections

&
[a From Web [% Recent Sources bl :

Get Refrash 5 [roperties

Data > From Table/Ra nge [‘E kxisting Connections All = b

Get & Transform Data TTes & Connections

o '3 I - TR | B R

For further information: Contact the BioNet team.
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